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Introduction 
 
 
FineCount – an essential software package for translators and translation managers – providing a 
wide range of features and functionality needed for document analysis. FineCount can quickly 
provide detailed statistics for documents in many different formats (Microsoft Word, PDF, HTML, and 
many, many others.) FineCount can also be used to prepare cost estimates and invoices for 
translation work. FineCount also allows the user to create their own report templates that can be 
reused with different documents. FineCount comes in two versions – standard and professional. The 
standard version provides general statistics about a document (characters, words, numbers) as well 
as cost estimates for translation. The professional version contains all the functionality of the 
standard version, as well as invoice generation functionality – including template configuration, 
advanced text analysis, and detailed text statistics (including word and sentence repetition analysis 
– including full output of words and sentences and how many times each was used). 
 
 
 
System requirements 
 
 
OS requirements: 
 
1) Windows 2000, Windows XP, Windows 2000 Server, Windows 2003 Server 
2) Internet Explorer 6 or higher 
3) Microsoft Office applications - for processing Microsoft office documents 
4) Adobe Reader 6, 7 or higher - for processing Adobe PDF files 
 
Minimal PC configuration: 
 
1) Intel Pentium I 133MHz 
2) Free 64MB of RAM - required memory amount depends on amount of data to be processed 
3) Free 5MB of disk space 
4) 800x600 display resolution 
 
Recommended PC configuration: 
 
1) Intel Pentium D 2.4+ GHz 
2) Free 256 MB of RAM 
3) Free 1GB of disk space 
4) 1280x1024 display resolution 
 
License agreement 
 
 
License agreement  
  
Please read the following terms and conditions carefully before using this software. Your use of this 
software indicates your acceptance of this license agreement. If you do not agree with the terms of 
this license, you must remove this software from your storage devices and cease to use the product.  
  



 
   

Copyright  
All versions of this software are protected by copyright laws and international copyright treaties, as 
well as other intellectual property laws and treaties. Tilti Systems Ltd. Software retains full title and 
rights to this software and documentation and in no way does the license granted diminish the 
intellectual property rights of Tilti Systems Ltd. Software. You must not redistribute the registration 
codes provided, on paper, electronically, or in any other form.  
  
Free version  
This is free version of software. After 15 days you must register your copy for free. 
 
Professional version  
This version is not free. Using this software without licence violates copyright laws and may result in 
severe civil and criminal penalties.  
  
Registered version  
One registered copy of this software may be used by a single person who uses the software 
personally or for commercial use. This software may not be used simultaneously on different 
computers. Alternatively this software may be installed on a single workstation used 
non-simultaneously by more than one person, but not both.  
  
Disclaimer  
THIS SOFTWARE IS PROVIDED "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESSED 
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, WARRANTIES OF MERCHANTABILITY OR 
FITNESS FOR A PARTICULAR PURPOSE. IN NO EVENT WILL TILTI SYSTEMS SOFTWARE BE LIABLE 
TO YOU FOR ANY DAMAGES, INCLUDING INCIDENTAL OR CONSEQUENTIAL DAMAGES, ARISING 
FROM THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGES. 
YOU ACKNOWLEDGE THAT YOU HAVE READ THIS LICENSE, UNDERSTAND IT, AND AGREE TO BE 
BOUND BY ITS TERMS.  
  
Distribution  
The evaluation version of this software may be distributed freely in its original unmodified and 
unregistered form. The distribution must include all files of its original distribution. Distributors may 
not charge any money for it. Anyone distributing this software for any kind of remuneration must first 
contact us for authorization.  
  
Other restrictions  
You may not modify, reverse engineer, decompile, or disassemble this software in any way, including 
changing or removing any messages or windows.  
  
© Tilti Systems Ltd., 2002-2006. All rights reserved. 
 
 
 



 
   

Version comparison 
 

Feature Free Pro Business Enter
prise 

 File statistics     
 Custom text analysis     
 Invoices and reports     
 Advanced text statistics     
 User profiles      
 Access shared files      
 Text export      
 Faster PDF analyzing     
 XML support     
 Extra features   info info 

 

 

Getting started 
 
 
 
 
Terminology 
 
 
Symbol – A letter, number, or special character (#, ?, %, etc). 
 
Word – A defined group of symbols, which is made up of letters, numbers or special characters. 
 
Sentence – A row of words, which ends with one of the symbols of sentence separation (most 
commonly the period, exclamation point, or question mark.) Note that the end of paragraph marker 
is always a sentence delimiter. 
 
Word connector - A symbol that is considered a part of a word. For example the ‘@’ character can 
be considered a word connector. Word connectors cannot be such symbols as spaces, end of line 
characters, or other control characters that cannot be displayed.  
 
Number – A word that is made up of only numeric characters and word connectors. This definition 
is also dependant on how the user has set the parameter Count words with numerals as 
numbers. 
 
 
 
Key features 
 
 

　 FineCount analyses documents in many different formats, including: 
o Microsoft Word (doc, dot, rtf, wri, wps) 
o Microsoft Excel (xls, xlt, xl?) 
o Microsoft PowerPoint (ppt, pot, pps) 



 
   

o Adobe PDF (pdf) 
o HTML documents (html, htm, mht, mhtml, shtml, shtm) 
o Text documents – (txt, ini, log) 
o Programmatic code and source code (pas, dpr, dpk, bpg, bdsproj, bdsgroup, dfm, 

xfm, c, cpp, php, java, js) 
　 Text analysis from the clipboard, in the event that the file format is not supported 
　 Any other files in text format 
　 Support for Unicode 
　 Correct analysis of hirogana, katakana, hieroglyphs and other special alphabets 
　 Advanced error reporting technology 

 
Functionality overview 
 
 
When given a document, FineCount will quickly analyse and process the document, and return 
statistics on the document to the user. The main uses of FineCount are: 
 

　 Document analysis – Provides information on documents – including, but not limited to – 
word count, sentence count, character count, with the ability to distinguish between words 
and numbers 

　 Statistical analysis – Provides information on sentence and word repetition 
　 Reports – Created detailed reports on documents that can be exported in many different 

formats. The user can also create templates for reports so that the reports reflect the exact 
information required by the user 

　 Invoice creation – FineCount allows the easy creation of invoices for translation work, 
based upon analysis of the document submitted 

 
 
 
First steps 
 
 
 
 
Opening a document for analysis 
 
 
Upon starting FineCount, the user will see the main FineCount window (Figure 2-1). 



 
   

 
Figure 2-1 

 
There are five methods of loading documents into FineCount: 
 
#1 – Drag and drop – click and drag a file into the FineCount window 
 
#2 – Add button 
 
The FineCount software has an Add button (Figure 2-2) that can be used to add files for analysis. 

 
Figure 2-2 

 
Upon clicking this button, the user will be presented with an explorer window, navigate to the folder 
that contains the document for analysis, and click on Open in the explorer window. 
 
#3 – File menu - The document can be opened via the File menu option. 
 
Clicking on File will display the dropdown menu (Figure 2-3). 

 
Figure 2-3 



 
   

 
Selecting Add will bring up an explorer window. Navigate to the folder that contains the document 
for analysis, and click on Open in the explorer window. 
 
#4 – Ctrl-o shortcut 
 
If the user presses ctrl-o, this shortcut key will bring up an explorer window. Navigate to the folder 
that contains the document for analysis, and click on Open in the explorer window. 
 
#5 – Copy/Past via Ctrl-C (in Explorer) followed by Ctrl-V (in FineCount) – this works for 
both folders and files. 
 
Useful tip: by dragging an entire folder into the FineCount window, all files in that folder will be 
analyzed (useful when the user wants to analyse a large number of documents). Note that there is 
also an Add folders with subfolders checkbox in the General tab of the configuration section of 
FineCount – this indicates that all subfolders will be included when using Add Folder or 
dragging/dropping folders into the FineCount window. 
 
 
 
Document analysis 
 
 
Once a document is added to the file count window, FineCount will begin its analysis of the document. 
This window (Figure 2-4) will appear briefly. 

 
Figure 2-4 

 
When the document has been analyzed, the document will appear in the Fine Count window (Figure 
2-5). 

 
Figure 2-5 

 
Already many statistics will be available to the user – words, words & numbers, etc (Figure 2-6). 



 
   

 
Figure 2-6 

 
And a preliminary cost will be displayed (Figure 2-7). 

 
Figure 2-7 

 
 
 
Invoice export 
 
 
For quick export of data, click on the Export to CB button (Figure 2-8).  

 
Figure 2-8 

 
This will export the analysis to the clipboard, where it can be pasted to the application of your choice 
– for example E-Mail. By default, the report will contain the following information (Figure 2-9). 
 

 
Figure 2-9 

Invoice button will export report to selected Invoice template file. 
 
Window layout 
 
 
The FineCount application window (Figure 3-1) is divided into the following sections. 



 
   

 
Figure 3-1 

 
Main menu – (Figure 3-2) Used to operate the software (operations with files, lists, reports and 
statistics). 

 
Figure 3-2 

 
List of files – (Figure 3-3) This section of the window will contain a list of the files for analysis. 
 
 

 
Figure 3-3 

 
Statistics – (Figure 3-4) Displays information about the checked files. 
 
 



 
   

 
Figure 3-4 

 
Report – (Figure 3-5) Displays the total cost for the work and gives the user the ability to manipulate 
certain variables in the calculation of the cost (rate, currency, tax percentage rate and discount 
percentage rate). This section of the window also gives the user the opportunity to export data. 
 

 
Figure 3-5 

 
Toolbar – (Figure 3-6) Provides quick access to frequently used functions of FineCount. 
 
Add – Adds a document to be analyzed. 
 
Paste – (Only available when information is available in the clipboard) – pastes copied information 
to FineCount. 
 
Remove – Removes the selected document from the FineCount window. 
 
Remove all – Removes all documents currently in the FineCount window. 
 
Refresh – Refreshes all information relating to documents currently in FineCount window. 
 
Advanced – Custom text analysis. 
 

 
Figure 3-6 

  
Settings - Hides/unhides the configuration section of FineCount. 
 
 
Configuration window – (Figure 3-7) allows for detailed configuration of the FineCount document 
analysis, as well as report configuration. 
 



 
   

 
Figure 3-7 

 

Configuration 
 
 
This section details the many configuration options of FineCount. Most configuration options are 
configured in the bottom section of the window – the following tabs are available (Figure 4-1). 

 
Figure 4-1 

 
Note – if these tabs are not visible, please click on the ‘Settings’ button (Figure 4-2). 

 
Figure 4-2 

 
This will show the configuration tabs. 
 
 
 
General configuration 
 
 
This section details general configuration of FineCount – including settings for how FineCount 
processes and analyses documents. 
 
Clicking on the General tab will display the following options (Figure 4-3). The following items can 
be configured in this tab: 

 
Figure 4-3 

 
Analysis window (Figure 4-4): 



 
   

 
Figure 4-4 

 
Count words with numerals as number – Checked/unchecked – this option indicates whether a 
word that contains numerals should be counted as a number.  
 
Ignore sentences containing only numbers – If checked, a sentence that only contains 
numbers will not be counted. Also – the numbers in this sentence are not included in the statistics. 
 
Sentence delimiters – This text box will contain all the characters that signal the end of a sentence. 
By default, this contains the characters period, exclamation point, and question mark. If a user needs 
additional sentence delimiters, they can be added here. 
 
Need space after – If Need space after is checked, then a space is required after a sentence 
delimiter to have the word before the delimiter to be counted as a word, as well as the group of words 
prior to the sentence delimiter to be considered a sentence.  
 
Ex #1 – word 
 
Sample.text. 
 
would be considered one word if Need space after is checked, and Logic is NOT checked as there 
is no space after the sentence delimiter (period). 
 
Ex #2 – sentence 
 
Hello.I am pleased to meet you. 
 
will be considered as one sentence if Need space after is checked and Logic is NOT checked, as 
there is no space after the sentence delimiter (period). 
 
Note that if Need space after is checked, then the Logic button will be grayed out. 
 
Use connector/delimiter logic – If the Use connector/delimiter logic checkbox is checked, 
then additional logic is applied when analyzing documents. This logic is only applied to a character 
that is in BOTH the Sentence delimiters box AND the Word Connector block – for example, the 
period (.) can be used to mark the end of a sentence as well as a symbol that connects words. If a 
sentence delimiter appears between two letters, the first one being small, and the second one being 
large, then it will be considered to be two sentences. For example – perhaps the user neglected to 



 
   

put a space after a period – and the period symbol is in both the Sentence delimiters box and the 
Word connectors box: 
 
Hello.I am pleased to meet you. 
 
note that there is no space after the first period – if Use connector/delimiter logic is checked, 
then the program will automatically  realize that this is two words – as the first sentence ends with 
a lower case letter ‘o’ and the next sentence starts with an upper case I. ‘Hello’ and ‘I’ will be 
considered two separate words, and ‘Hello.I am pleased to meet you.’ will be considered two 
sentences. 
 
If Logic is NOT checked, then ‘Hello.I’ will be considered one word, and “Hello.I am pleased to meet 
you.” will be considered one sentence. 
 
If a sentence delimiter is between two lowercase characters, then it will not be processed as a 
sentence delimiter. 
 
For example: 
 
My email is name@email.com. 
 
Note that there is a sentence delimiter (.) between email and com. Since the ‘l’ prior to the period and 
the ‘c’ after the period are both lowercase, this period will NOT be considered as a sentence delimiter 
– and the above text will be processed as one sentence of four words. 
 
Word connectors: A word can contain other defined symbols – word connectors, which are 
configurable in the section General->Word connectors. If any of the word connectors include 
also sentence delimiters, then the result is dependant on the settings of Need space after and Use 
connector/delimiter logic. Please see the Terminology help for more detail regarding word 
connectors. 
 
For example, by default – the ‘@’ character and the period ‘.’ are both considered to be word 
connectors. 
 
So the sentence 
 
My email is name@email.com. 
 
is made up of four words – with name@email.com being all one word – as it contains two word 
connectors – ‘@’ and ‘.’ 
 
A user can configure as many word connectors as needed. 
 
Han ideograph and hangul syllable as word – If this option is checked, then every Japanese or 
Chinese complex symbols is counted as a word (hirogana, katakana symbols is counted as a 
character, but complex hieroglyphs as a word). If unchecked, then each symbol is processed as a 
character. 
 
Unknown files as text – This indicates that if a file is given to FineCount with an unknown file type, 
then FineCount will assume it is a text document. If this box is NOT checked, then FineCount will NOT 
analyse unknown files. 



 
   

 
Add folders with subfolders – This indicates that FineCount will not only include all documents in 
a submitted folder, but also all documents in any subfolders in that original folder. 
 
 
Statistics window (Figure 4-5): 

 
Figure 4-5 

 
Automatically analyse file statistics – If this box is checked, then as soon as a file is opened by 
FineCount, it will be analyzed and the results displayed. Note that if this box is not checked, then 
Automatically analyse repetitions and Automatically calculate text statistics will both be 
grayed out. Also – if this box is not checked, two new buttons will appear in the Statistics window – 
Count and Analyse. Also note – the Analyse button only appears when the text has not had the full 
statistics calculated. 
 
Before the document has been analyzed, all statistics will be set to ‘N/A’ (Figure 4-6). 

 
Figure 4-6 

 
Automatically analyse repetitions – If this box is checked, then as soon as a file is opened by 
FineCount, repetitions in the text will be analyzed and the results displayed separately for each file. 
 
Automatically calculate text statistics - If this box is checked, then as soon as a file is opened 
by FineCount, text statistics will be calculated and made available for ALL documents being analyzed. 
 
 Text in program source files window (Figure 4-7): 

 
Figure 4-7 

 
Analyse string constants – If this box is checked, then the analysis of the source code provided to 
FineCount will include string constants. 
 
Analyse comments - If this box is checked, then the analysis of the source code provided to 
FineCount will include comments. 



 
   

 
Application window (Figure 4-8): 

 
Figure 4-8 

 
Confirm application exit – If this box is checked, a popup window will appear (Figure 4-9) when 
the user attempts to exit out of FineCount, so to confirm the exit. 

 
Figure 4-9 

 
Skinned border – If this box is checked, then the border of the FineCount window will have a more 
streamlined appearance. If not checked, then FineCount will have the traditional Windows border. 
This is purely a cosmetic setting, and has no effect at all on FineCount functionality. 
 
XML window (for XML files) (Figure 4-3): 
 
If Attribute values option is checked - only xml attributes' values will be processed.  
 
Node values - only nodes' values will be processed from xml file.   
 
Both values - FineCount processes all attributes' and nodes' values from xml file.  
 
MS Office configuration 
 
 
This section details configuration options when analyzing Microsoft Office (MS Word, MS Excel, MS 
PowerPoint) documents with FineCount (Figure 4-10).  

 
Figure 4-10 

 
Word window (Figure 4-11): 



 
   

 
Figure 4-11 

 
Here many options can be configured – whether or not the user wants FineCount to include in its 
processing the following: plain text, Textboxes, WordArt, AutoShapes, comments, footnotes, 
endnotes, fields, diagrams, and grouped objects. Also processing of headers and footers are 
configured – and additional configuration is available if the user would prefer to process only unique 
headers/footers (headers/footers that do not necessarily change every page – only every new 
section of the document) by selecting Each Section – or if ALL headers and footers, regardless if 
they change or not – are processed – by selecting Each Page. 
 
By default, Exclude fields is NOT checked – if you wish FineCount to exclude the fields that are 
contained in the Microsoft Word document, please check this box. 
 
Excel window 
 
The Excel window (Figure 4-12) allows a user to configure which aspects of Microsoft Excel should be 
analyzed by FineCount. 

 
Figure 4-12 

Configuration options include analysis of: plain text, Textboxes, WordArt, AutoShapes, Comments, 
Diagrams, Sheet Titles, Charts, Grouped Objects, as well as Axis and Chart Titles. 
 
PowerPoint window 
 
The PowerPoint window (Figure 4-13) allows a user to configure which aspects of Microsoft 
PowerPoint should be analyzed by FineCount. 



 
   

 
Figure 4-13 

 
Configuration options include analysis of the following: PlaceHolders, Textboxes, WordArt, 
AutoShapes, Comments, Diagrams, and Grouped objects. 
 
Publisher window 
 
The Publisher window (Figure 4-14) allows a user to configure which aspects of Microsoft Publisher 
should be analyzed by FineCount. 

 
Figure 4-14 

 
Configuration options include analysis of the following: Shapes, WordArt, Headers, Footers, 
Alternative texts, and Grouped objects. 
 
OpenOffice & StarOffice window 
 
The OpenOffice & StarOffice window (Figure 4-15) allows a user to configure which aspects should 
be analyzed by FineCount. 

 
Figure 4-15 

 
Configuration options include analysis of the following: Document text, Text frames, Footnotes and 
Endnotes. 
 
Text statistics 
 
 
If configured, immediately after loading documents into FineCount, a number of statistics will be 
displayed, both in the main window – (Figure 5-1) - which displays detailed statistics for each 
document analyzed. 



 
   

 
Figure 5-1 

 
Statistics are also displayed in the statistics window – (Figure 5-2) - which displays total statistics for 
all documents. Note that this is only available when Automatically calculate text statistics has 
been selected. 
 

 
Figure 5-2 

 
Main window 
 
 
Please be aware that there is a scrollbar at the bottom of the main window that allows a user to scroll 
through all the statistics (Figure 5-3) that have been made available. 

 
Figure 5-3 

 
The statistics available are: 
 
(It is advised that the user familiarizes themselves with the Terminology section to fully understand 
the definition of terms like ‘Word’, ‘Number’, ‘Sentence’, etc.). 
 
File name – The name of the file for which statistics are being provided 
Only words – Number of words in the document 
Words & numbers – Number of words + numbers in the document 
% of numbers – Percentage of the document that consists of numbers 
Characters – Number of characters in the document (not including spaces) 
Characters & spaces – Number of characters and spaces 
Lines – Number of lines in the document 
Sentences – Number of sentences 
Sentence repetitions % - Percentage of sentences that are repeated 
Pages – Number of pages 
Words (MS Office), Characters (MS Office), Characters & spaces (MS Office), Lines (MS 
Office), Paragraphs (MS Office), Pages (MS Office) – Statistics taken directly from the 
Microsoft Word statistics. Only available when analysing MS Word documents 
 
 



 
   

 
Statistics window 
 
 
This window (Figure 5-4) contains totals for all documents analyzed. 

 
Figure 5-4 

 
Characters – Number of characters in the document (not including spaces) 
Characters & spaces – Number of characters and spaces 
Words – Number of words in the document 
Words & numbers – Number of words + numbers in the document 
% of numbers – Percentage of the document that consists of numbers 
Sentences – Number of sentences 
Lines – Number of lines in the document 
Sentence repetitions % - Percentage of sentences that are repeated 
 
 
 
Text statistics tab 
 
 
For additional text statistics, the user can click on the Text statistics tab (Figure 5-5). 

 
Figure 5-5 

 
This tab can provide information about repetition of words and sentences by providing statistics 
about how many times a certain word or sentence appears in the selected documents. 
 
Case sensitive  - If this checkbox is checked, then the analysis will be case sensitive. For example 
‘The’ and ‘the’ will be counted separately. If this button is not checked, then words of the same 
characters, even if case is different, will be counted as the same – ‘The’ and ‘the’ will be counted as 
the same word. 
 



 
   

Show words – This will display a list of all words used in the documents, as well as statistics of how 
many times the words appear (Figure 5-6). 

 
Figure 5-6 

 
Show sentences - This will display a list of all sentences used in the documents, as well as statistics 
of how many times the sentences appear. 
 
Note that these statistics can be sorted in alphabetic order, or by number of repetitions (ascending 
or descending) by clicking on the column header. 
 
Reports and invoices 
 
 
FineCount offers powerful reporting functionality to the user. From simple statistical reports to 
complex invoices, FineCount allows the user to tailor their reporting to fit their exact needs (Figure 
6-1). 

 
Figure 6-1 

 
 
 
Report tab 
 
 
When creating reports, the following options are available to be configured. 
 



 
   

Rating type: The type of document analysis to be used in the report or invoice generated. Options 
include: Words with numbers, characters, characters with spaces, lines, pages, words. 
 
Line length: Here the length of a line in the report or invoice to be created can be specified. Default 
value is 55, but this is configurable as necessary. Also there is a drop down window that indicates 
what this figure actually represents – default value is characters, though this can be changed to 
characters with spaces, words, or words with numbers. 
 
Page size: This setting indicates the size of the output page. The default is 1024, and can be 
configured as necessary. Also there is a drop down window that indicates what this figure actually 
represents – default value is characters with spaces, though this can be changed to characters, 
words, or words with numbers. 
 
Report template: In this section, the user can select a template for the report to be created. There 
is a default template provided, or users can create their own template. The template created will be 
in HTML format – for easy additional to web documents and online reports. 
 
If the user clicks on the Create button, a new window will appear (Figure 6-2). 
 



 
   

 
Figure 6-2 

 
This window configures the report fields. The user can give the template a unique name in the ‘New 
Template’s Name’ text box. 
 
This window allows the user to configure all the fields that will appear in the report. For a field to 
appear in the report, the check box next to the name must be checked. In the above picture, the field 
‘Characters’ will appear, but the field ‘Character & spaces’ will NOT appear. 
 
Also, the user has the option to change the name of the column header in the report as well. By 
default, the column name that will be displayed in the report is the same name as the parameters – 
for example ‘Characters’. However, the column header can be changed by changing the value in the 
text box. 
 
The user also has the option of configuring whether or not the totals for all documents are displayed 
in the report. For the totals for any particular configuration option to be displayed, the ‘Totals’ 
checkbox for that parameter must be checked. 
 



 
   

Once the user has configured the report output to be as needed, the ‘Create’ button can be pressed, 
and a new template will be created. 
 
Pressing Cancel will close this window and no changes will be saved. 
 
The user also has the option to edit existing templates (however, the Default template can NOT be 
edited). By selecting a user-created template (Figure 6-3), the additional buttons will be activated: 

 
Figure 6-3 

 
The user can now Rename the template, Delete the template, as well as Edit and Preview the 
template. 
 
If the user selects Edit, then the template will appear in HTML format, and the user will have to edit 
the actual HTML. 
 
Clicking on the ‘?’ will display a complete list of tags that can be in the HTML report.  
 
Invoice template: The user can configure an invoice template so to be able to quickly and easily 
generate ready invoices to be sent to clients. The invoice template must be created in Microsoft Word, 
and it must contain the tags to be displayed in the invoice. 
 
For example, if the user were to create a MS Word template document (Figure 6-4) (with 
extension .dot) that contained only: 
 
<%files_data%> 

 
Figure 6-4 

then the user must open that document template in FineCount by clicking on the ‘…’ button (Figure 
6-5). 

 
Figure 6-5 

 
This will open an explorer window. The user must then navigate to the location of the file and open 
it. The name of the file, as well as its location, will now appear in the Invoice template text box 
(Figure 6-6). 

 
Figure 6-6 



 
   

 
Clicking on Edit will open the MS Word document template for editing. 
 
At this point, the user can click on the Invoice button in the report window (Figure 6-7). 

 
Figure 6-7 

 
That will generate an MS Word file that replaces the tag with the actual value (Figure 6-8). 

 
Figure 6-8 

 
There are many tags available that can be added to the MS Word invoice template. The full list can 
be viewed by clicking on the ? button in the Invoice template section of the Reports configuration 
window. 
 
 
 
HTML tags 
 
 
This is a complete list of HTML tags that are available in FineCount: 
 
This tags are usable in HTML report templates. 
Please note that all tags are case sensitive! 
 
General tags 
    <!- %document_lines_start%--> - tag indicates, that file block started (only in templates) 
    <!--%document_lines_end%--> - tag indicates, that file block finished (only in templates, this 
section will be copied for every file)  
 
Global tags:      
    %date% - insert current date 
    %rate% - insert rate 
    %currency% - insert currency 
    %tax% - insert tax percentage 
    %discount% - insert discount percentage 



 
   

    %rating_object% - insert rating object title (pages, sentences, lines...) 
    %rating_object_item% - insert rating object's subtype title (only for line and page, for other objects 
this value is the same as object)  
    %rating_object_item_size% - insert rating object's subtype element count (only for line and page, 
for other objects this value is 1)  
    %line_objects% - insert line's element title 
    %page_objects% - insert page's element title 
    %line_size% - insert line's element count 
    %page_size% - insert page's element count  
    %program_name% - insert program name (FineCount) 
    %program_version% - insert program version  

Document tags: 
    %document_file_name% - current file's name 
    %document_words% - words in current file 
    %document_words_with_numbers% - words with numbers in current file 
    %document_lines% - lines in current file 
    %document_pages% - pages in current file 
    %document_sentences% - sentences in current file 
    %document_characters% characters in current file 
    %document_spaces% spaces in current file 
    %document_characters_with_spaces% - characters with spaces in current file 
    %document_hangul% - han ideograph and hangul syllable in current file 
    %totals_ms_words% - MS Office words in current file 
    %totals_ms_lines% - MS Office lines in current file 
    %totals_ms_paragraphs% - MS Office paragraphs in current file 
    %totals_ms_pages% - MS Office pages in current file 
    %totals_unique_words% - unique words in current file 
    %totals_unique_sentences% - unique sentences in current file 
    %document_sentence_repetitions% - sentence repetitions in current file 
    %document_file_path% - file's path 
    %document_currency% - currency 
    %document_amount% - amount without tax and discount in current file 
    %document_tax_amount% - tax amount in current file 
    %document_discount_amount% - discount amount in current file 
    %document_amount_all% - total amount in current file 

Total tags: 

    <%totals_words%> - total words 
    <%totals_words_with_numbers%> - total words with numbers 
    <%totals_lines%> - total lines 
    <%totals_pages%> - total pages 
    <%totals_sentences%> - total sentences 
    <%totals_characters%> - total characters 
    <%totals_spaces%> - total spaces 
    <%totals_characters_with_spaces%> - total characters with spaces 
    <%totals_ms_characters%> - total MS Office characters 
    <%totals_ms_spaces%> - total MS Office spaces 
    <%totals_ms_characters_with_spaces%> - total MS Office characters with spaces 
    <%totals_ms_words%> - total MS Office words 
    <%totals_ms_lines%> - total MS Office lines 
    <%totals_ms_paragraphs%> - total MS Office paragraphs 
    <%totals_ms_pages%> - total MS Office pages 
    <%totals_hangul%> - total han ideograph and hangul syllable 



 
   

    <%totals_unique_words%> - total unique words 
    <%totals_unique_sentences%> - total unique sentences 
    <%totals_sentence_repetitions%> - global sentence repetitions 
    <%totals_amount%> - total amount without tax and discount 
    <%totals_tax_amount%> - total tax amount 
    <%totals_discount_amount%> - total discount amount 
    <%totals_amount_all%> - total amount 
    <%totals_file_count%> - total file count 

 
 
 
Microsoft Word tags 
 
 
This is a complete list of Microsoft Word tags that are available in FineCount: 
 
This tags are usable in Microsoft Word invoice template. 
Please note that all tags are case sensitive! 
 
General tags:     
    <%files_data%> - insert file list with information 
        (place this some where in your MS Word template if needed) 
 
Document tags:     
    11/10/2006 - insert current date 
    <%rate%> - insert rate 
    <%currency%> - insert currency 
    <%tax%> - insert tax percentage 
    <%discount%> - insert discount percentage 
    <%rating_object%> - insert rating object title (pages, sentences, lines...) 
    <%rating_object_item%> - insert rating object's subtype title 
        (only for line and page, for other objects this value is the same as object)  
    <%rating_object_item_size%> - insert rating object's subtype element count 
        (only for line and page, for other objects this value is 1)  
    <%line_objects%> - insert line's element title 
    <%page_objects%> - insert page's element title 
    <%line_size%> - insert line's element count 
    <%page_size%> - insert page's element count  
    <%program_name%> - insert program name (FineCount) 
    <%program_version%> - insert program version  
 
Total tags: 
    <%totals_words%> - total words 
    <%totals_words_with_numbers%> - total words with numbers 
    <%totals_lines%> - total lines 
    <%totals_pages%> - total pages 
    <%totals_sentences%> - total sentences 
    <%totals_characters%> - total characters 
    <%totals_spaces%> - total spaces 
    <%totals_characters_with_spaces%> - total characters with spaces 
    <%totals_ms_characters%> - total MS Office characters 
    <%totals_ms_spaces%> - total MS Office spaces 



 
   

    <%totals_ms_characters_with_spaces%> - total MS Office characters with spaces 
    <%totals_ms_words%> - total MS Office words 
    <%totals_ms_lines%> - total MS Office lines 
    <%totals_ms_paragraphs%> - total MS Office paragraphs 
    <%totals_ms_pages%> - total MS Office pages 
    <%totals_hangul%> - total han ideograph and hangul syllable 
    <%totals_unique_words%> - total unique words 
    <%totals_unique_sentences%> - total unique sentences 
    <%totals_sentence_repetitions%> - global sentence repetitions 
    <%totals_amount%> - total amount without tax and discount 
    <%totals_tax_amount%> - total tax amount 
    <%totals_discount_amount%> - total discount amount 
    <%totals_amount_all%> - total amount 
    <%totals_file_count%> - total file count 
 
Report preview tab 
 
 
Prior to creating a report or an invoice, the user can preview the report in the Report preview tab 
(Figure 6-9). 

 
Figure 6-9 

 
The data shown in the Report preview tab is dependant upon which report template has been 
selected in the Report tab. 
 
 
 
Report calculations 
 
 
This section details the calculation of the total amount in the Report window. These parameters can 
be changed, as the user requires (Figure 6-10). 

 
Figure 6-10 

 
The options available here are: 
 



 
   

Rate – The price per object (note that this depends on the setting of Rating Type in the Report tab 
in the FineCount bottom window – Words, Words & Numbers, Characters, etc. 
 
Tax % - What percentage tax rate should be applied to the total amount. 
 
Currency – The currency to be used in the invoice (note that the currency setting has no effect on 
the calculations). 
 
Discount % - What discount will be applied to the final total. 
 
The following formulas are used in calculations: 
 
Net Amount = Object Count * Rate 
 
Discount Amount = Net Amount * Discount % 
 
Tax Amount = (Net Amount – Discount Amount) * Tax % 
 
Total Amount = Net Amount – Discount Amount + Tax Amount 
 
Complete Formula: 
 
Total Amount = (Net Amount – (Net Amount * Discount %) ) * (1 + Tax %) 
 
A complete example: 
 
Documents submitted to FineCount, with Total Amount to be calculated based upon the number of 
Words & Numbers (Set in the Report tab) (Figure 6-11). 

 
Figure 6-11 

 
The resulting statistics are as follows (Figure 6-12): 

 



 
   

Figure 6-12 
 
Rate = 0.06 EUR / Word/Number 
Tax % = 15% 
Discount % = 5% 
 
The calculation would look like: 
 
2027 (Words with numbers) * 0.06 (Rate) = 121.62 EUR (net amount) 
Discount = 121.62 * 0.05 = 6.08 EUR 
Amount after discount = 115.54 EUR 
Tax = 115.539 * 0.15 (tax rate) = 17.33 EUR 
 
Total amount = 115.54 + 17.33 = 132.87 EUR 
 
 
 
 
Toolbar 
 
 
The following options are available on the FineCount toolbar (Figure 7-1). 
 

 
Figure 7-1 

 
 
 
File menu 
 
 
If the user clicks on the File drop down menu, the following menu will appear (Figure 7-2). 
 

 
Figure 7-2 

 
The options here are very similar to the FineCount quick access toolbar. 
 
Add – Adds a document to be analyzed. 
 
Add folder – Adds a folder (including all documents contained in that folder) to be analyzed. 
 
Remove – Removes the selected document from the FineCount window. 



 
   

 
Remove all – Removes all documents currently in the FineCount window. 
 
Exit – Exits FineCount. 
 
 
 
Edit window 
 
 
If the user clicks on the Edit drop down menu, the following menu will appear (Figure 7-3). 

 

 
Figure 7-3 

 
The options here are Change rate, Rename and Paste. 
 
Rename – When a file has been selected in the FineCount window, this option allows the user to 
rename the file. 
 
Paste will paste a copied file or text from the clipboard to the FineCount window for analysis. 
 
 
 
Change rate 
 
Clicking on Change rate will offer to change the rate's value for documents in the FineCount window  
(Figure 7-4). 

 
Figure 7-4 

 
After clicking OK rate's value updating takes place automatically for all selected documents. 
 
View menu 
 
 
Clicking on the View menu in the FineCount toolbar will show the following options (Figure 7-5). 
 



 
   

 
Figure 7-5 

 
 
 
Edit columns 
 
Edit columns – Allows the user to manually configure which columns will be visible, as well as their 
order  
(Figure 7-6). 
 

 
Figure 7-6 

 
The user can check or uncheck any of the available columns. The up arrow and down arrow moves 
a particular column up or down the list (this is if the user wishes to change the order of the columns 
that are displayed). 
 
Changes are automatically applied. 
 
 
 



 
   

Refresh 
 
 
FineCount offers the user the ability to refresh all statistics as well as the list of documents currently 
being analyzed by FineCount by using the Refresh command (or by pressing the F5 key). This is 
useful when the user wants to remove files that no longer exist from the list of files. Note – if 
Automatically analyse file statistics is not checked, then the statistics will NOT be refreshed – 
only files that no longer exist will be removed.  
 
Toggle settings 
 
 
Much like the Settings button in the FineCount main window, Toggle settings hides and shows the 
configuration settings section of the FineCount window. 
 
 
 
List columns 
 
 
Clicking on List columns in the View window will display a sub menu (Figure 7-7). 

 
Figure 7-7 

 
Show all columns – Displays all available columns. 
 
Hide all columns – Removes all columns from the display. The only column remaining will be File 
Name. 
 
 
 
 
List style 
 
 
Clicking on List style under the View menu, the user will see two additional menu items (Figure 
7-8). 
 



 
   

 
Figure 7-8 

 
These options give the user to opportunity to change the appearance of the FineCount main window. 
 
List – Only displays the names of the files being analyzed. 
 
Report – Displays detailed information about the files being analyzed. 
 
 
 
Skinned border 
 
 
Skinned border allows the user to alternate between the standard Windows border and a more 
streamlined appearance. This is purely a cosmetic setting, and has no effect at all on FineCount 
functionality. 
 
 
 
Toolbar 
 
 
Clicking on Toolbar under the View menu will display the following sub-menu (Figure 7-9). 
 

 
Figure 7-9 

 
This gives the user the option of where, if at all, to display the FineCount toolbar (Figure 7-10). 
 

 
Figure 7-10 

 



 
   

Top – Toolbar is displayed above the FineCount main window. 
 
Bottom – Toolbar is displayed below the FineCount main window. 
 
Off – Toolbar is not displayed at all. 
 
 
 
Tools menu 
 
 
The Tools menu gives the user access to the exporting and analysing functionality of FineCount  
(Figure 7-11). 
 

 
Figure 7-11 

 
Note that there will be an extra menu item – Count under the Tools menu if Automatically 
analyse file statistics under the General tab in the configuration section is NOT checked (Figure 
7-12). 
 

 
Figure 7-12 

 
 
 
Export statistics 
 
 
The Export statistics option in the Tools menu allows the user a choice of methods for exporting 
the FineCount output – as text, as HTML, or exporting the results to the clipboard (Figure 7-13).  

 



 
   

 
Figure 7-13 

 
Note that the output exported is the contents of the FineCount statistics window. 
You can customize output with Edit text and Edit HTML commands like report templates. 
 
Export 
 
 
This menu option actually exports the contents of a file to a new file (Figure 7-14). The contents of 
multiple files being analyzed by FineCount will be exported to one single file. 
 

 
Figure 7-14 

 
Export with numbers – This indicates that all the text will be exported – including numbers. 
 
Export without numbers – This indicates that the text will be exported WITHOUT numbers. 
 
Clicking on either of the two above options will prompt the user to select a directory and enter the 
name of the text file to be created. The contents of the documents will be exported in plain Unicode 
text format. 
 
The user also has the option of exporting the data to the clipboard (Figure 7-15). 
 

 
Figure 7-15 

 
The user has the same options – export with numbers, or export without numbers. Once the data has 
been exported to the clipboard, the output can be copied to the application of the user’s choosing. 
 



 
   

Count 
 
 
Count only appears if Automatically analyse file statistics under the General tab in the 
configuration section is NOT checked (Figure 7-16). 
 

 
Figure 7-16 

 
Count will recalculate statistics for all selected documents. 
 
 
 
Custom text analysis 
 
 
Custom text analysis allows the user to analyse a specific portion of a submitted text. 
 
Selecting Custom text analysis, the user will see the following window (Figure 7-17). 
 

 
Figure 7-17 

 
With this, the user can analyse the text both in specific blocks (Extract), as well as the inverse – 
analyse all text, EXCLUDING the specified blocks (Remove).  
 
The Match case checkbox allows the user to configure whether or not it is necessary to differentiate 
between lowercase and uppercase letters in the values of the Start and End parameters. For 
example, if the Start parameter was ‘The’ and Match case was checked, then a ‘the’ would not be 
considered as a valid Start value, as the ‘t’ is lowercase. 



 
   

 
If Remove trailing spaces is checked, then all trailing spaces from the document will be removed 
after custom analysis. 
 
The user can also specify the starting and ending text or characters by specifying them in the Start 
and End text boxes. Analysis will only take place of text that is between the Start and End 
characters – the text contained in the Start and End boxes will be analyzed too. 
 
Pressing on the Analyse button will commence the custom file analysis, keeping in mind the user’s 
specified requirements. 
 
Note – if either or both Start or End are blank, then automatically the program will consider these 
to be either the end-of-paragraph delimiter or the end of the file. 
 
If Analyse line by line box is checked, the text will be analyzed line by line sequentially. 
 
The Export button works similarly to the other export functionality in FineCount, however, it will only 
export the data analyzed in this custom text analysis. 
 
Clicking on Export will display an additional menu (Figure 7-18). 
 

 
Figure 7-18 

 
With numbers – This indicates that all the custom text will be exported – including numbers. 
 
Without numbers – This indicates that all the custom text will be exported WITHOUT numbers. 
 
To clipboard – This brings up an additional menu where the user can select how the text will be 
exported to the clipboard (Figure 7-18). 
 
 
With numbers – This indicates that all the custom text will be exported to the clipboard including 
numbers. 



 
   

Without numbers – This indicates that all the custom text will be exported to the clipboard 
WITHOUT numbers. 

Examples 
 
The text to be analyzed was the following: 
 
The quick fox 
jumped over the 
lazy dog. 
 
No Settings Result 
1 Action: Extract; 

„Analyse line by line” is checked; 
Start set is empty; 
End set is empty. 

"The quick fox 
jumped over the 
lazy dog." 

2  Action: Extract; 
 „Analyse line by line” is checked; 
 Start: „fox”; 
 End: „over”; 

 - 

3  Action: Extract; 
 „Analyse line by line” is checked;  
 Start: „fox”; 
 End set is empty. 

"fox" 

4 Action: Extract; 
„Analyse line by line” is checked; 
Start set is empty; 
End: „over”. 

"jumped over"  

5 Action: Extract; 
Start set is empty; 
End set is empty. 

"The quick fox 
jumped over the 
lazy dog." 

6 Action: Extract; 
Start: „fox”; 
End: „over”. 

" fox 
jumped over" 

7 Action: Extract; 
Start: „fox”; 
End set is empty. 

"                  fox 
jumped over the 
lazy dog." 

8 Action: Extract; 
Start set is empty; 
End: „over”. 

"The quick fox 
jumped over" 

9 Action: Remove; 
„Analyse line by line” is checked; 
Start set is empty; 
End set is empty. 

 -  

10 Action: Remove; 
„Analyse line by line” is checked; 
Start: „fox”; 
End: „over”; 

"The quick fox 
jumped over the 
lazy dog." 

 
11 Action: Remove; 

„Analyse line by line” is checked; 
Start: „fox”; 
End set is empty. 

"The quick       
jumped over the 
lazy dog." 
 

12 Action: Remove; 
„Analyse line by line” is checked; 
Start set is empty; 
End: „over”. 

"The quick fox 
                the 
lazy dog." 



 
   

13 Action: Remove; 
Start set is empty; 
End set is empty. 

 -  

14 Action: Remove; 
Start: „fox”; 
End: „over”; 

"The quick 
                  the 
lazy dog." 

15 Action: Remove; 
Start: „fox”; 
End set is empty. 

"The quick " 

16 Action: Remove; 
Start set is empty; 
End: „over”. 

"               
            the 
lazy dog." 

 
Pressing on the Batch button will open/close special scripts editor. Editor allows to change script's 
code and load it for further execution (Figure 7-19).  
 
Add to batch adds to batch script's code.  
 

 
Figure 7-19 

 
 

 
MetaChanger 
 
MetaChanger 

MetaChanger helps you to quick manage meta information - to create and update files' 
metainformation. It allows to remove not only summary information, but also all NTFS additional 
data streams (Figure 7-20). An essential tool provides mass update summary information from all 
types source documents. 



 
   

 
Figure 7-20 

 

To manage metainformation it is necessary to select files and edit information in MetaChanger form. 
Process files button updates checked files. 

If Automatically process files when they are loaded option is checked - files will be appended 
or updated with metainformation automatically.  

 

 

  

 
Report menu 
 
 
The Report menu in the FineCount menu bar offers the user the following options (Figure 7-21). 

 
Figure 7-21 

 
Preview – This opens the Report preview tab in the FineCount bottom window. 
 
Full Screen – This will display the report in full screen format. 
 



 
   

When in Full screen view, the user has the following menu options available (Figure 7-22). 
 

 
Figure 7-22 

 
To close the Full Screen, click on Close full screen or press F10. 
 
Save – Saves report in .html  format. 
 
Convert to PDF – Creates an invoice and then converts it to pdf file (Free CutePDF Printer is 
required. You can obtain it at http://www.cutepdf.com). 
 
Export to CB – Exports the report information to the clipboard. 
 
Invoice – Creates an invoice in Microsoft Word based upon the data in the report. Please note that 
an Invoice template (in the Report tab) must be configured for the invoice to be properly created! 
 
 
 
Help menu 
 
 
Clicking on Help in the FineCount menu bar will display (Figure 7-23). 
 

 
Figure 7-23 

 
FineCount help – Displays help contents. 
 
Check for updates - Checks and updates FineCount. 
 
FineCount on the web - Brings you to FineCount web site. 
 
Registration - offers to register FineCount program by inserting serial number (Figure 7-24).  
 



 
   

 
Figure 7-24 

 
About – Displays FineCount version information and registration state (Figure 7-25). 
 

 
Figure 7-25 

 

Messages and Errors 
 
 
 
 
File Import 
 
 
 
 
HTML file import 
 
 
Message: 
 
HTML Loading Not Completed In 10 Seconds. Please Select Action: 
 Yes - Continue loading, No - Stop Loading Content, Cancel - Skip Content. 
 



 
   

Description: 
 
If, when loading HTML documents, the loading process takes more than ten seconds, FineCount will 
display this informational message to the user, at which point the user can cancel the loading if it is 
deemed necessary. At times there are HTML documents that load ad infinitum in FineCount (note 
that FineCount uses Internet Explorer to load HTML documents), and the user will not see the 
notification “Document loading finished” displayed by the FineCount software. This is because 
FineCount waits for a “Done” message from Internet Explorer. In the case that the documentation 
loading takes longer than 10 seconds, FineCount will ask the user if loading should continue. 
 
 
 
PDF file import 
 
 
Message: 
 
(When Opening a PDF file). 
 
PDF Processing Requires that Acrobat Reader and Acrobat be Closed! 
 To Close Acrobat Programs Press [Yes], Or [No] To Cancel Processing Files. 
 
Description: 
 
For FineCount to properly analyse a PDF document, Adobe Acrobat and Reader must be closed. 
Clicking Yes will close the specified applications. No will ignore the PDF files and continue processing. 
 
 
Message: 
  
Acrobat Reader must be installed to analyse PDF files! 
 
Description: 
 
Adobe Acrobat Reader must be installed for FineCount to be able to analyse the submitted file. 
 
Solutions: 
 

　 Ensure that, at a minimum, Acrobat Reader version 6.0 is installed (version 7.0.0.5 is the 
recommended version. 

　 Close all instances of Acrobat Reader and Acrobat (if installed) services and tasks (via Task 
Manager), and then try again. 

　 Restart FineCount. 
 
Message: 
  
Cannot start Acrobat application! 
 
Description: 
 



 
   

The Adobe Acrobat Reader cannot be started.  
 
Solutions: 
 

　 Ensure that, at a minimum, Acrobat Reader version 6.0 is installed (version 7.0.0.5 is the 
recommended version. Close all instances of Adobe applications. 

 
 
 
Microsoft Office file import 
 
 
Message: 
 
Cannot start Word application! Microsoft Word must be installed to analyse Word files! 
 
Description: 
 
FineCount could not start Microsoft Word. 
 
Solutions: 
 
Microsoft Word must be installed to analyse Word files 
Close all instances of Microsoft Word, and processes via Task Manager as necessary 
Ensure that enough memory is available to load application and document 
Restart FineCount 
 
Message:  
 
Cannot open Word document! 
 
Description: 
 
FineCount could not open the specified Word document. 
 
Solutions: 
 
Microsoft Word must be installed to analyse Word files 
Close all instances of Microsoft Word, and processes via Task Manager as necessary 
Ensure that enough memory is available to load application and document 
Ensure that the specified document is in fact a Microsoft Word document 
Restart FineCount 
 
Message: 
 
Cannot start Excel application! Microsoft Excel must be installed to analyse Excel files! 
 
Description: 
 
FineCount could not start Microsoft Excel. 
 



 
   

Solutions: 
 
Microsoft Excel must be installed to analyse Word files 
Close all instances of Microsoft Excel, and processes via Task Manager as necessary 
Ensure that enough memory is available to load application and document 
Restart FineCount 
 
Message: 
 
Cannot open Word document! 
 
Description: 
 
FineCount could not open the specified Excel document. 
 
Solutions: 
 
Microsoft Excel must be installed to analyse Excel files 
Close all instances of Microsoft Excel, and processes via Task Manager as necessary 
Ensure that enough memory is available to load application and document 
Ensure that the specified document is in fact a Microsoft Excel document 
Restart FineCount 
 
Message: 
 
Cannot start PowerPoint application! Microsoft PowerPoint must be installed to 
analyse PowerPoint files! 
 
Description: 
 
FineCount could not start Microsoft PowerPoint. 
 
Solutions: 
 
Microsoft PowerPoint must be installed to analyse Word files 
Close all instances of Microsoft PowerPoint, and processes via Task Manager as necessary 
Ensure that enough memory is available to load application and document 
Restart FineCount 
 
Message: 
 
Cannot open PowerPoint document! 
 
Description: 
 
FineCount could not open the specified PowerPoint document. 
 
Solutions: 
 
Microsoft PowerPoint must be installed to analyse Excel files 
Close all instances of Microsoft PowerPoint, and processes via Task Manager as necessary 



 
   

Ensure that enough memory is available to load application and document 
Ensure that the specified document is in fact a Microsoft PowerPoint document 
Restart FineCount 
 
 
 
Internet Explorer related 
 
 
Message:  
 
Cannot start Internet Explorer application!  Microsoft Internet Explorer must be 
installed to analyse Word files! 
 
Description: 
 
The Microsoft Internet Explorer application could not be started. 
 
Solutions. 
 

　 Ensure that Microsoft Internet Explorer is installed 
　 Close all IE windows 
　 Ensure that enough memory is available to load application and document 
　 Restart FineCount 

 
 
 
File export 
 
 
Message: 
 
Text cannot be exported to a file that is included in the export list! 
 
Description: 
 
Exported data cannot be exported to a file that has already been opened by FineCount 
 
Message: 
 
File Already Exists! Replace? 
 
Description:  
 
The file to be exported to already exists. The user has the option of cancelling this action or replacing 
the existing file. 
 
Message: 
 
File Access Error! 



 
   

 
Description: 
 
FineCount is unable to export to the specified file – this can be due to security settings (the user does 
not have the authorization to write to the specified file). 
 
Solutions: 
 

　 Ensure that the user has the proper permissions to be able to export this file 
Close all instances of Acrobat Reader and Acrobat (if installed) services and tasks (via Task Manager), 
and then try again 
 
Message: 
 
Error Occurred While Exporting the File <...>! Output File May Be Corrupt! 
 
Description: 
 
FineCount will notify the user if there were problems during the export by letting the user know that 
the export file that has been created may be corrupt. 
 
Solutions: 
 

　 Ensure that the user has the proper permissions to be able to export this file 
　 Ensure that all necessary Microsoft Office components are working properly. Close all any 

existing instances of Microsoft Office programs (verify via Task Manager that no processes are 
running) 

　 Ensure that the program has enough memory to be able to load the selected file 
　 Restart FineCount 

 
Message: 
 
Operation Cancelled! 
 
Description: 
 
The specified operation has been cancelled by the user. No action has been taken. 
 
Message: 
 
File <...> Doesn't Exist! 
 
Description:  
 
One of the exported files no longer exists…The file specified does not exist. The user must verify that 
the specified file exists. 
 
Solutions: 

　 Recreate list of files to analyse 
　 Restart FineCount 



 
   

 
Message: 
 
Failed To Open Clipboard! 
 
Description: 
 
Fine Count was unable to open the Clipboard – the user will need to verify that the Windows clipboard 
functionality is working properly. 
 
Solutions: 
 

　 Retry operation 
　 Restart FineCount 

 
Message: 
 
Failed To Rename File! 
 
Description: 
 
Fine Count was unable to rename the specified file. 
 
Solutions: 
 

　 Ensure that a file with that name does not already exist 
 
 
 
Report generation 
 
 
Message: 
 
Error Generating Report! 
 
Description: 
 
There was a problem when generating the report file. The user will need to verify all report settings, 
and attempt to generate the report again. 
 
Solutions: 
 

　 Check Internet Explorer’s ability to display pages 
　 Check modify permissions for FineCount program folder 
　 Restart FineCount 

 
 
 



 
   

General 
 
 
Message: 
 
It is recommended to restart the program after seeing an exception.  
 
Description: 
 
If when using FineCount, the user encounters a FineCount exception, please close and restart the 
program. 
 
 
 
Analysis 
 
 
Message: 
 
Analyse Completed In 0 Min 0 Sec 0 Ms! 
 
Description: 
 
A notification message to let the user know that the document has been successfully analyzed, as 
well as how long the analysis took to perform. 
 
 
 
Template 
 
 
Message: 
 
Template file already exists! Replace? 
 
Description: 
 
A prompt to the user as to whether or not the specified template really should be deleted. 
 
Message: 
 
Failed To Rename File! 
 
Description:  
 
FineCount was unable to rename the specified file. 
 
Solutions: 
 

　 Try another template name 



 
   

　 Check permissions for FineCount\Templates folder 
 
Message:  
 
Error saving template! Filename may be incorrect!  
 
Description:  
 
FineCount was unable to save the template with the specified name. 
 
Solutions: 
 

　 Try another template name 
　 Check permissions for FineCount\Templates folder 

 
 
 
Report export 
 
 
Message: 
 
Please Select Invoice Template File First! 
 
Description: 
 
A Report Template must be selected before an invoice can be generated. 
 
Message: 
 
Report Invoice Template File Doesn't Exist! 
 
Description: 
 
The specified template does not exist. The user must specify an existing template. 
 
Message: 
 
Error Connecting To MS Word Server! 
 
Description: 
 
Unable to open MS Word program – ensure that MS Word is installed and running properly on the 
machine. 
 
Solutions: 
 

　 Install MS Word 
　 Close all Word instances and processes 
　 Restart FineCount 



 
   

 
 
 
Export statistics 
 
 
Message: 
 
File Already Exists! Replace? 
 
Description: 
 
The file to which the user wishes to export statistics already exists – this prompt asks the user 
whether the existing file should be replaced or not. 
 
Message: 
 
New filename: 
 
Description: 
 
Allows the user to specify the name of the new file. 
 
 
 
List operations 
 
 
Message: 
 
Failed To Rename File! 
 
Description: 
 
The specified file could not be renamed. 
 
Solutions: 

　 Check permissions for the selected file and ensure that the file exists 
 
 
 
Profile 
 
 
Message: 
 
Profile With This Name Already Exists! Replace? 
 
Description: 
 



 
   

The profile name specified by the user already exists – the user is queried as to whether or not to 
replace the existing profile. 
 
Message: 
 
Error Saving Profile! 
 
Description: 
 
Profile could not be saved. 
 
Solutions: 
 

　 Check permissions for Folder FineCount\Config 
 
Message: 
 
Failed To Rename Profile! 
 
Description: 
 
Profile could not be renamed. 
 
Solutions: 
 

　 Check permissions for the folder FineCount\Config 
 
Message: 
 
New Name For Profile ...: 
 
Description: 
 
If a user wishes to change the name of a profile, this message box appears and queries the user for 
the new name of the profile. 
 
 
 
Profiles 
 
 
FineCount allows the user to set up different profiles. Certain users will have changed the layout and 
settings of FineCount, and will want those changes to be available when restarting FineCount (Figure 
8-1). 

 
Figure 8-1 

 
The FineCount active profile is stored in the file FineCount.ini. When a new profile is loaded, it will 
overwrite the existing profile.  
 



 
   

To create a new profile, make the necessary changes in the FineCount that are to be saved. Then 
press the green plus button. This will bring up the new profile creation window (Figure 8-2). 
 

 
Figure 8-2 

 
Name the profile accordingly, then press OK. 
 
Upon clicking on the dropdown profile menu, all available profiles will be displayed (Figure 8-3).   

 
Figure 8-3 

 
Select the desired profile from the profile drop down window. Note that when selecting profiles, the 
FineCount window will disappear briefly. 
 
Changes made in an existing profile can be saved. Press the green plus button again, and enter the 
existing name of the file. The program will prompt the user to confirm the overwriting of the existing 
profile. 
 
If a user saves a new profile, the information is stored in the file Config\<name_of_profile>.ini. Any 
changes upon exiting will be stored in that profile. The information is also stored in the active profile, 
and every time FineCount is closed, the information is updated in the active profile as well. 
 
To remove a profile from the list of profiles, select the profile to be deleted from the dropdown list, 
and then click on the red X button. Note that the default profile CANNOT be deleted. 
 
 
 
FAQ 
 
 
Q: Why is the analysis result zero for any file after it has been added to the file list? 
 
A: It is possible that you do not have the option “Automatically analyse files” turned on. That must be 
turned on if you would like files to be automatically analyzed. 
 
Also check that there are no invalid symbols in the file name – specifically symbols that are different 
than the system language. For example, if system language is Russian, then allowed characters are 
Russian and English characters. If other symbols are used in the file name (which Windows allows, 
but will cause problems in FineCount processing) – so for example if a file name contains Latvian 
characters, FineCount will not process the file. 
 
Correct:  



 
   

 
abcdefghijklmnopqrstuvwxyz_йцукенгшщзхъфывапролджэячсмитьбюё.txt 
 
Incorrect: 
 
āčēū.txt 
 
Q: How can we analyse Word, Excel, or PowerPoint documents if we do not have these 
programs installed on all machines? 
 
A: The only option is to use Microsoft Word, Excel, or PowerPoint viewer and copy the necessary text 
into the clipboard, then, from the clipboard, copy into FineCount. This method can be used with all 
other documents that are not supported by FineCount. 
 
Q: If there is a certain section of a document that I do not wish to analyse – for 
example, a section of text in the document that begins with “[“ and ends with “]” – is 
there any way to remove this section from the analaysis? 
 
A: For this you will need to use Tools -> Custom Text Analysis. Set Start to “[“ and End to “]” 
(omitting the quotation marks), Remove spaces = false and Remove = true. See the Custom Text 
Analysis section for more detailed information. 
 
Q: How can I configure invoices for my needs? 
 
A: This is detailed in the section Reports and invoices. 
 
 
Q: How can I configure HTML templates for my needs? 
 
A: This is detailed in the section Reports and invoices. 
 
Q: How can I determine the mechanism for calculating the Total Amount in the Report 
window? 
 
A: The formula for calculations is described in the section Report calculations. 
 
Q: I get a zero count result for a certain PDF file though there is text in it. What's 
wrong? 
 
A: Please check that the system requirements for Acrobat software are adhered to and this is not a 
scanned (e.g. a fax) or protected PDF file. If this is a scanned image, you will need to use OCR 
software first before you will be able to count the files with FineCount. The file might be protected 
from copying and text extraction. In this case it cannot be counted as well, you will need to remove 
the protection first. 
 
Q: What is the difference between Standard and Business versions? 
 
A: Please see the version comparison here. 
 
Q: Why does analysis of a Microsoft Office document take a long time? 
 



 
   

A: This is dependant on the power of the machine. If you are using anti-virus software, then you have 
the opportunity to close Office plug-ins (if such exist). 
 
Q: Why are Word and PowerPoint statistics indicating a smaller word count than 
FineCount? 
 
A: Word, Excel and PowerPoint do not count text in headers, footers, comments, Textboxes, 
autoshapes and other objects. FineCount can count this text with the proper settings set. 
 
Q: Can I request a feature in FineCount that I find necessary? 
 
A: Of course. Our employees will carefully consider all request and will work to improve FineCount so 
that is fulfils all of a client’s needs. Please send feature requests to software@tilti.com. 
 
Q: Why do certain files not have MS Word statistics columns? 
 
A: The MS Word statistics are only available to MS Word documents being analyzed. 
 
Helpful tips 
 
 

 　 You do not need to buy Microsoft Office to analyse documents using FineCount, you 
can simply install the free Microsoft Word, Excel, PowerPoint Viewer and use the clipboard 
to put the text of the documents into FineCount (ctrl+c in the associated viewer program 
and then ctrl+v in the FineCount program). 

 　 You can process also other file formats with FineCount using the clipboard. 
 　 With FineCount, you can extract or delete unwanted text blocks (for example, you can 

remove comments from and html file) using the FineCount Custom text analysis. 
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